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1 Introduction 
The TCS3530 evaluation kit comes with everything needed to evaluate the TCS3530. The 

device features true color XYZ ambient light detection, as well as flicker detection up to 7 kHz, 

which makes it able to detect flicker from modern LED lighting systems. 

1.1 Kit content 

Figure 1: Evaluation kit contents 

 

No. Item Description 

1 TCS3530 EVM Daughter Card PCB with TCS3530 EVM sensor installed 

2 EVM Controller Board Used to communicate USB to I²C 

3 USB Cable (A to Micro-B) Connects EVM controller to PC 

4 Flash Drive Includes application installer and documents 
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1.1.1 Ordering information 

 

Ordering code Description 

TCS3530 Eval Kit Eval Kit for TCS3530 

 

2 Getting started 
The software should be installed prior to connecting any hardware to the computer. Follow the 

instructions found in the Quick Start Guide (QSG). This loads the required driver for the USB 

interface and the device’s graphical user interface (GUI). 

The balance of this document identifies and describes the controls available on the GUI. In 

combination with the TCS3530 datasheet, the QSG and application notes available on the  

ams OSRAM website, ams-osram.com, there should be enough information to allow 

evaluation of the TCS3530 device. 

3 Hardware description 
The hardware consists of the EVM Controller, the TCS3530 EVM daughter card, and a USB 

interface cable. The EVM controller board provides power and I²C communication to the 

daughter card through a seven-pin connector. When the EVM controller is connected to the PC 

through USB, a green LED on the board lights to indicate the system is getting power. The 

LED will remain lit until a software application opens the controller. The light will then be 

switched off so that it will not interfere with any light measurements. 

For schematics, layout and BOM information please see the documents included with the 

install located in the TCS3530 EVM folder (All Programs -> ams-OSRAM -> TCS3530 EVM -> 

Documents). 
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Figure 2: Evaluation kit hardware 

 

4 Software description 
The main window (Figure 3) contains the system menus, system level controls, device 

information and logging status. The configuration tab contains controls to set up both ALS and 

Flicker detection parameters. The ALS tab displays Color data and has a plot area where raw 

ALS data can be plotted. The Flicker tab displays information about the Flicker Detection 

function and has a plot area where raw Flicker data and calculated FFT data can be displayed. 
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Figure 3: GUI main window 

 

4.1 Connect software to hardware 

On startup, the software automatically connects to the hardware. On successful initialization, 

the software displays a main window, containing controls pertinent to the connected device. If 

the software detects an error, an error window appears. If “Device not found or is unsupported” 

appears, verify the correct daughterboard is properly connected to the EVM controller board. If 

“Cannot connect to EVM board” appears, verify the USB cable is connected. When the EVM 

controller is connected to the PC through USB, a green LED on the board lights to indicate the 

system is getting power. The LED will remain lit until an application opens the controller. The 

light will then be switched off so that it will not interfere with any light measurements. 

If the EVM board disconnects from the USB bus while the program is running, it displays an 

error message and then terminates. Reconnect the EVM board and restart the program. 
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4.2 System menus 

At the top of the window there are pull-down menus labeled “File”, “Log”, and “Help”. The File 

menu provides basic application-level control. The Log menu controls the logging function, 

and the Help menu provides version and copyright information for the application. 

4.2.1 File menu 

The File menu contains the following functions: 

Figure 4: File menu 

 

The Reread Registers function forces the program to re-read all of the control registers from 

the device and display them on the screen. This does not read the output data, because the 

program reads those registers continually while it is running. 

Click on the Exit command to close the main window and terminate the application. Any 

unsaved log data is cleared from memory. The application can also be closed by clicking the 

red “X” in the upper right hand corner. 

4.2.2 Log menu 

The Log menu controls the logging function and saves the log data to a file. Log data 

accumulates in memory until discarded or written to a data file. 

Figure 5: Log menu 

 

 

https://ams-osram.com/support/technical-support-form?category=document-feedback


TCS3530 EVM 
 Software description 

 

  

Eval Kit Manual • PUBLIC • Document Feedback  
UG001030 • v3-00 • 2023-Dec-12 8 / 20 

/ 

Click Start Logging to start the logging function. Each time the program polls the output 

information from the device, it creates a new log entry showing the raw data values, the values 

of various control registers, and the values entered by the user into the text fields near the 

bottom right corner of the window.  

Click Stop Logging to stop the logging function. Once logging stops, the user may store the 

data in a file, or continue collecting additional data by clicking Start Logging again.  

The Log a Single Entry command causes logging to start, collect one single entry, and 

immediately stop again. This function is not available when logging is already running.  

Click Clear Log to discard any previously collected data. If there is data in memory, which has 

not been saved to disk, this function displays a prompt asking to verify it is OK to discard the 

data. If the log is active when this function executes, the log continues running after the 

existing data is discarded.  

Click Save Log to save the collected log data to a csv file. This stops the logging function, if it 

is active, and displays a file dialog box to specify where to store the logged data. The Log 

Status and Control Information section below describes the default file name, but you may 

change the file name if desired. 

4.2.3 Help menu 

The Help menu contains a single function: About. 

Figure 6: Help menu 

 

The About function displays a dialog box (Figure 7) showing the version and copyright 

information for the application and library. Click the OK button to close this window and 

continue. 
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Figure 7: About window 

 

4.3 System level controls 

Immediately below the top menu bar is the Power On checkbox. This controls the PON 

function of the TCS3530. When this box is checked, the oscillator is on and the device is 

running measurements according the settings in the Configuration tab. At this time, the 

Configuration tab is disabled to prevent changing settings while the measurement is ongoing. 

When this box is unchecked, the device does not collect data. The Configuration tab is then 

enabled and you can change the controls to setup the parameters for next running. 

4.4 Auto polling 

The application automatically reads the TCS3530 raw ALS and Flicker. The Poll Interval at 

the upper right corner of the form, displays the actual time between screen updates. The time 

is controlled by the settings of the ALS and Flicker functions and will be affected by the speed 

and workload of the PC that is running the GUI program. 
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4.5 Device ID information 

The lower left corner of the window displays the unique ID of the EVM Controller board, 

identifies the device being used and displays the ID and serial number of the TCS3530 device. 

Figure 8: Device ID information 

 

4.6 Log status and control information 

The lower right corner of the window contains status information and controls for the logging 

function: 

Figure 9: Logging status 

 

This section contains text boxes that are stored in the log file data and used to build the file 

name for the log file. If the data in these fields are changed, the new values are stored with any 

new data logged. The default file name is based on the value in the right-hand textbox, at the 

time the log file is written. If nothing is entered in the boxes they default to a period (“.”) 

Sample default file name: 

TCS3530_1-2-3_Log_HH_MM_SS.csv 

  From Application 

  From User Input 

The Count value displayed is a count of the number of samples currently in the log buffer. 

The Elapsed Time value is the total time that has elapsed between the first log sample and 

the current sample. 

The pulldown control in the lower right corner is used to control the maximum size of the log 

file. When the number of samples of log data reaches the specified value, the GUI will 

automatically stop logging and perform a Save Log command, which will display the Save File 
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dialog box. The stored log data is cleared and can be started again by selecting the Start 

Logging function. 

4.7 “Configuration” tab 

The main portion of the screen contains a tab labeled Configuration. The controls on this tab 

are disabled while data collection is running. To enable this tab, stop data collection by 

unchecking the Power On checkbox. 

Figure 10: Configuration tab 

 

4.7.1 Configuration controls 

The Configuration Tab contains controls that affect the operation of the ALS and Flicker 

functions. 

The SAMPLE_TIME control adjusts the time for every ALS or Flicker sample. Each sample is 

(SAMPLE_TIME + 1) × 1.38889 µs. The resulting time and frequency are displayed 

immediately to the right of this control. 
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The ALS group displays controls for ALS data collection. 

• The ALS Enable checkbox controls whether ALS data is collected. If this box is checked, 

the ALS data is collected. If the box is unchecked ALS is not done. 

• The number of samples summed together to create each ALS measurement is controlled 

by the ALS_NR_SAMPLES control. The actual number of samples is one more than this 

control and is shown immediately to the right of the control. After the ALS samples are 

collected and summed, a single result per channel will be written to the device FIFO. 

• The ALS Integration Time is calculated using the sample time and number of ALS 

samples and is displayed in the upper right corner of this box. 

The Flicker group displays controls for the Flicker function. 

• The Flicker Enable checkbox controls whether Flicker Detection is performed. If this box 

is checked, the Flicker function is performed. If the box is unchecked, Flicker Detection 

(FD) is not done. 

• Because the amount of Flicker data can be quite large, the TCS3530 uses a data 

compression algorithm to reduce the amount of data that must be transferred. The 

Compression Width control allows changing the basic data width that is used for this 

compression. When the device is running, the Flicker Tab shows the efficiency of the data 

compression. 

• The Modulator pulldown controls which photodiode is used for the Flicker function. 

• FD_NR_SAMPLES controls the number of samples which are collected for Flicker 

Detection. Unlike the ALS function, these samples are not added together. Each sample is 

written to the device FIFO. The actual number of samples is one more than this control 

and is shown immediately to the right of the control. 

• The FD Measurement Time is calculated using the sample time and number of FD 

samples and is displayed at the bottom of this box. 

The group in the lower left corner of the Configuration Tab controls functions relating to the 

autozero and oscillator functions. 

• CALIB_NTH_ITERATON selects the repeat rate of the autozero and AGC functions. If this 

value is set to 0, the step is never performed. If it is set to 255, it is only performed 1 time 

after startup. If it is set to any other value, n, the step is performed every nth time 

• The checkbox labeled Autozero at nth iteration controls whether the autozero function 

and AGC are performed, or just an AGC is performed. 
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• The OSC_CALIB pulldown controls when/if the oscillator is synchronized with the VSYNC 

signal. The TCS3530 can internally generate a VSYNC signal if the external VSYNC is not 

received. This control specifies how often the internal oscillator is synchronized. If this 

control is set to “disable”, the oscillator is never synched to the VSYNC signal. If “after 

pon” is selected, the oscillator is synchronized only with the first VSYNC after PON is set 

to 1. If “always on” is selected, the synchronization occurs for every VSYNC signal. 

• The “at VSYNC Frequency” control specifies the rate at which an internal VSYNC should 

be generated (if necessary) and the expected frequency of the VSYNC for 

synchronization. This control can be set to 60 Hz, 90 Hz, or 120 Hz. 

The Gains group controls functions related to the gain of the ALS and Flicker data collection. 

• The Common Gain checkbox and pulldown are not actual register fields. They are 

provided, by the GUI, to provide an easy way to set all of the gain values at one time. If the 

Common Gain checkbox is checked, the individual gain pulldown controls will be disabled 

and all of the individual gain values will be set based on the Common Gain pulldown 

menu. When the checkbox is unchecked, the Common Gain pulldown menu will be 

disabled and all of the individual gain controls will be enabled, 

• The ALS Gain group provides controls to individually set the ALS gain for all 8 channels. If 

the Common Gain checkbox is checked, these controls will be disabled. While the device 

is running, each gain pulldown will reflect the most recent gain for the channel. If the AGC 

functions are enabled, these values will change when the gain values are changed by the 

hardware. Values for the gain controls includes all powers of 2, ranging from ½ through 

4096. 

• The Flicker Gain Control sets the gain value for the collection of Flicker Data. It also can 

be controlled via the Common Gain controls and will reflect any changes due to AGC. 

Values for the gain control includes all powers of 2, ranging from ½ through 4096. 

• The Predictive AGC checkbox controls whether the predictive AGC function is used. To 

disable AGC, both the Predictive and Saturation AGC checkboxes must be unchecked. 

• The Saturation AGC checkbox controls whether the saturation AGC function is used. To 

disable AGC, both the Predictive and Saturation AGC checkboxes must be unchecked. 

• The Residual checkbox controls whether the residual values from the ADCs will be 

collected and added to the raw data values for ALS and Flicker. The residual values 

provide a higher accuracy to the ALS and Flicker values that can be useful in low-light 

environments. If the residual function is disabled, the corresponding low-order bits of the 

ALS and Flicker values will be 0. 
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The Wait Time group, at the bottom center of the tab, controls the time between measurement 

cycles. 

• The Timing pulldown menu controls whether the wait time is enabled and the time base 

used to measure the wait, when enabled. The Timing value is used with the WTIME 

control to determine the total wait time between measurements. This value can be set to 

“off”, 2.8444 ms, 45.5110ms, 88.8889 µs, 1.4222 ms, or “vsync”. If “off” is selected, no wait 

time will be added between measurements. If “vsync” is selected, the device will wait one 

VSYNC per WTIME step. 

• WTIME specifies the number of the selected Timing steps to wait between measurements. 

The actual number of steps is one more than the register value (WTIME = 0 means 1 

step). If the Timing control is set to “off”, this control is disabled. The total wait time 

specified by the Timing and WTIME controls is displayed immediately to the right of this 

control. Note that if Timing is set to “vsync” this displayed time is not accurate. In this case 

the wait time is simply WTIME + 1 VSYNC signals. 

The AGC Time group, in the lower right corner of the tab, controls the number of AGC 

samples. 

• The AGC_NR_SAMPLES control specifies the number of samples for every AGC 

measurement. The actual number of samples is one more than AGC_NR_SAMPLES and 

is displayed immediately to the right of this control. 

• The AGC Integration Time is calculated using the sample time and number of AGC 

samples and is displayed at the bottom of this box. 
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4.8 “ALS” tab 

The main portion of the screen contains a tab labeled ALS. It displays ALS measurement data. 

Figure 11: ALS tab 

 

4.8.1 Color data 

The ALS color data is displayed on the top left side of the tab. The data is displayed using the 

CIE XYZ color space and the CIE xy color space. The Lux and CCT are also displayed. 

4.8.2 Raw ALS status 

At the bottom left of the tab there are four columns for each of the eight data channels. 

• The first column lists the channel number and describes the associated frequency band. 

The TCS3530 datasheet lists the specific characteristics of each channel. 

• The second column shows the raw count value for the channel. This data is not calibrated, 

and has not been adjusted based on gain. 

• The third column shows the gain value that was used to collect the data for that channel. 
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• The fourth column indicates the saturation status for the channel. If the box is green, the 

channel was not saturated during the data collection. If any saturation was detected in a 

channel during data collection, the box will be red. 

The graph on the ALS Tab is a CIE 1932 color space chromaticity diagram. If the Enable Plot 

box is checked, a single point, at the calculated (x, y) values will be plotted. This point will 

move as the x and y values change. 

4.9 Flicker tab 

The main portion of the screen contains a tab labeled Flicker. This tab displays a graph of up 

to 512 points of the raw Flicker data. As a demonstration, it also calculates an FFT and 

displays lists the frequency bins with the highest power. It can also display a representation of 

the calculated FFT data. 

Figure 12: Flicker tab 

 

4.9.1 Flicker configuration information 

At the top left of the screen, Flicker settings from the Configuration Tab are displayed. These 

include the total Sampling Time, the Sampling Frequency and the FD_GAIN value that was 

used to collect the data. 
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4.9.2 Flicker frequencies 

Below the configuration information, the Frequencies of the largest 3 bins from the FFT are 

displayed. The FFT is always calculated using 512 input points. If FD_NR_SAMPLES is set to 

more than 512 samples, only the first 512 will be used. If FD_NR_SAMPLES is less than 512 

samples, the data will be padded with zeros to create 512 points, but doing so will cause the 

output of the FFT to be inaccurate. 

4.9.3 Flicker data plot 

Checking the Show FFT checkbox will display the FFT output data. The red labels at the top of 

the graph are only present when Show FFT is checked, and indicate the frequency of the FFT 

points. The FFT data does not show any Y-Axis values since, by the nature of the FFT 

calculations, the scale may be different for every FFT and the relative magnitudes of the data 

points is what is pertinent for peak detection. 

The black labels at the bottom of the graph are always present and simply represent the 

number of points displayed. The Y-Axis scale of the raw data can be controlled using the small 

up/down arrows immediately above the left edge of the graph. The range of the axis can be set 

to any power of two from 16 through 65536, and is displayed immediately to the right of the 

arrows. 

4.9.4 Data compression status 

At the bottom of the data on the left side of the tab, the program displays information to show 

the reduction of FIFO data due to data compression. This information includes the number of 

bytes that are actually received from the FIFO, the number of bytes that would be required for 

uncompressed data and a ratio of the uncompressed size to the compressed size. 

In the example shown in Figure 12, the FD_NR_SAMPLES is set to 512 samples. Since each 

sample is 16 bits, this would normally require 1024 bytes. Because of data compression, only 

601 bytes were actually placed into the FIFO. This resulted in a 1.7 : 1 compression ratio. 
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5 Resources 
For additional information regarding the TCS3530, please refer to the datasheet. For 

information regarding the installation of the TCS3530 EVM host application software please 

refer to the TCS3530 EVM Quick Start Guide. 

Designer’s Notebooks dealing with various aspects of optical measurement and optical 

measurement applications are available. All content is available on the ams OSRAM website 

ams-osram.com. 

 

 
Referring documents:  

• TCS3530 Datasheet 

• TCS3530 EVM Quick Start Guide, QG001020 (QSG) 

• TCS3530 EVM User’s Guide (this document) 

• TCS3530 EVM Schematic Layout 

 

https://ams-osram.com/support/technical-support-form?category=document-feedback
https://ams-osram.com/


TCS3530 EVM 
 Revision information 

 

  

Eval Kit Manual • PUBLIC • Document Feedback  
UG001030 • v3-00 • 2023-Dec-12 19 / 20 

/ 

6 Revision information 
Definitions 

Draft / Preliminary: 
The draft / preliminary status of a document indicates that the content is still under internal review and subject to change without notice. ams-OSRAM 
AG does not give any warranties as to the accuracy or completeness of information included in a draft / preliminary version of a document and shall 
have no liability for the consequences of use of such information. 

 

Changes from previous released version to current revision v3-00 Page 

Document contents transferred to latest ams OSRAM template  

Document security class is updated to “PUBLIC” in the footer  

 

● Page and figure numbers for the previous version may differ from page and figure numbers in the current revision. 

● Correction of typographical errors is not explicitly mentioned. 
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7 Legal information 
Copyright & disclaimer 

Copyright ams-OSRAM AG, Tobelbader Strasse 30, 8141 Premstaetten, Austria-Europe. Trademarks Registered. All rights reserved. The material 

herein may not be reproduced, adapted, merged, translated, stored, or used without the prior written consent of the copyright owner. 

Demo Kits, Evaluation Kits and Reference Designs are provided to recipient on an “as is” basis for demonstration and evaluation purposes only and 

are not considered to be finished end-products intended and fit for general consumer use, commercial applications and applications with special 

requirements such as but not limited to medical equipment or automotive applications. Demo Kits, Evaluation Kits and Reference Designs have not 

been tested for compliance with electromagnetic compatibility (EMC) standards and directives, unless otherwise specified. Demo Kits, Evaluation 

Kits and Reference Designs shall be used by qualified personnel only. 

ams-OSRAM AG reserves the right to change functionality and price of Demo Kits, Evaluation Kits and Reference Designs at any time and without 

notice. 

Any express or implied warranties, including, but not limited to the implied warranties of merchantability and fitness for a particular purpose are 

disclaimed. Any claims and demands and any direct, indirect, incidental, special, exemplary or consequential damages arising from the inadequacy 

of the provided Demo Kits, Evaluation Kits and Reference Designs or incurred losses of any kind (e.g. loss of use, data or profits or business 

interruption however caused) as a consequence of their use are excluded. 

ams-OSRAM AG shall not be liable to recipient or any third party for any damages, including but not limited to personal injury, property damage, loss 

of profits, loss of use, interruption of business or indirect, special, incidental or consequential damages, of any kind, in connection with or arising out 

of the furnishing, performance or use of the technical data herein. No obligation or liability to recipient or any third party shall arise or flow out of ams-

OSRAM AG rendering of technical or other services. 

ams OSRAM semiconductor RoHS compliance statement 

RoHS compliant: The term RoHS compliant means that ams-OSRAM AG semiconductor products fully comply with current RoHS directives. Our 

semiconductor products do not contain any chemicals for all 6 substance categories plus additional 4 substance categories (per amendment EU 

2015/863), including the requirement that lead not exceed 0.1% by weight in homogeneous materials.  

Important information: The information provided in this statement represents ams-OSRAM AG knowledge and belief as of the date that it is 

provided. ams-OSRAM AG bases its knowledge and belief on information provided by third parties, and makes no representation or warranty as to 

the accuracy of such information. Efforts are underway to better integrate information from third parties. ams-OSRAM AG has taken and continues to 

take reasonable steps to provide representative and accurate information but may not have conducted destructive testing or chemical analysis on 

incoming materials and chemicals. ams-OSRAM AG and ams-OSRAM AG suppliers consider certain information to be proprietary, and thus CAS 

numbers and other limited information may not be available for release. 

Headquarters 

ams-OSRAM AG 

Tobelbader Strasse 30 

8141 Premstaetten 

Austria, Europe 

Tel: +43 (0) 3136 500 0 

Please visit our website at ams-osram.com 

For information about our products go to Products 

For technical support use our Technical Support Form 

For feedback about this document use Document Feedback 

For sales offices and branches go to Sales Offices / Branches 

For distributors and sales representatives go to Channel Partners 
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